
���������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������

������������������������������������������������������������������������������������������������������������
���������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������

������������������������������������������������������������������������������������������������������������
���������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������

TUTORIALDiagramação no Linux: Um Jornal com o Scribus

���������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������
45edição 06www.linuxmagazine.com.br 

No último mês, mostrei como 
criar um projeto de editoração 
eletrônica no Scribus e ensinei 

os primeiros passos para esboçar nosso 
jornalzinho de exemplo com a importa-
ção e inserção do nome do jornal no alto 
da primeira página. Também demos 
uma ol hada na forma de colocar o texto 
numa caixa de texto. Este mês, vere-
mos mais detalhadamente como inse-
rir, ajustar, encaixar e destacar o texto. 
Mas, em primeiro lugar, vamos falar da 
tarefa de colocar a fotografi a principal 
na primeira página.

Importando uma imagem
A imagem principal é uma foto ou outra 
imagem gráfica que acompanha um 
artigo e é colocada próximo ao alto da 
página. O arquivo de imagem é criado 
separadamente e em seguida importado 
para o Scribus. Começa-
remos colocando uma 
imagem principal na pri-
meira página de nosso 
jornal de Linux.

A primeira compli-
cação com que depara-
mos ao importar uma 
imagem gráfi ca para o 
Scribus é a falta geral 
de suporte para espaços 
de cor CMYK no Linux. 
Como você aprendeu 
mês passado, a compo-
sição em CMYK é fun-
damental na editoração 

eletrônica profi ssional. Através desse 
processo, imagens coloridas podem 
ser quebradas em seus tons compos-
tos de ciano, magenta, amarelo e preto. 
Embora a gama de cores que pode ser 
obtida na impressão em CMYK seja 
menor que a gama de vermelho, verde 
e azul de um monitor, mais tons podem 
ser reproduzidos com sucesso.

O principal editor de bitmap para 
Linux é o Gimp, que é efetivamente um 
clone do Adobe Photoshop 3. Porém, 
diferente do Photoshop, até ha bem 
pouco tempo o Gimp não dava suporte 
a espaços de cor CMYK. Felizmente o 
Gimp 2.0 já pode trabalhar em CMYK 
com o plugin gimp-cmyk (veja o quadro 

“Instalação do plugin  gimp-cmyk”). Ele 
permite ao usuário converter uma ima-
gem RGB para camadas CMYK indivi-
duais (usando Perfi s de Cor de origem e 

destino especifi cados) e 
em seguida salvar essa 
coleção de camadas 
como um TIFF CMYK.

Para importar uma 
imagem para o Scribus, 
selecione primeiro New 
Image Frame na barra 
de ferramentas, depois 
clique e arraste a mol-
dura retangular até que 
esteja mais ou menos 
do tamanho desejado.

Em seguida importe a 
imagem escolhendo File 

> Import > Get Picture.

Finalizando a Imagem
Após importar a foto, posicione-a exata-
mente no local desejado e altere o tama-
nho dela caso necessário.

Cada publicação tem seu próprio 
estilo, o que é normalmente refle-
tido nos guias de estilo. O East Belfast 
Observer exige uma linha preta, com 
dois pontos de largura, em torno de cada 
imagem. Isso não apenas cria um visual 
classudo como também serve para fi ns 
técnicos. Muitas impressoras de jornal 

“saem do registro” – isso signifi ca que 
as pranchas de quatro cores usadas na 
impressão se desalinham e a imagem 
acaba saindo borrada, quase sempre 
fugindo dos seus limites. Uma linha de 
dois pontos tem duas vezes a largura de 
uma linha comum – seria muito inco-
mum que uma das pranchas de cor se 
desalinhasse em mais de dois pontos. 
Portanto, mesmo se a impressora sair do 
registro, a linha preta ajudará a deixar a 
página um pouco mais limpa.

Como todas as fotografi as neste nosso 
projeto apresentarão essa linha, é uma 
boa idéia criar um estilo que possa ser 
aplicado a qualquer imagem sem ter de 
recriá-la manualmente todas as vezes.

Para criar um estilo, selecione 
Edit>Line Styles. Na caixa de diálogo 
que aparece, selecione New. Surge uma 
nova janela, na qual definiremos o 
estilo de nossa linha (fi gura 1).

No alto da janela, digite um título 
para o estilo, como linha2pt. Na janela 
há também opções para ajustar as 

Na segunda desta série em três capítulos [1], Jason 

Walsh trata de alguns detalhes da confecção de um 

jornal no Scribus. Veremos também como admi-

nistrar aqueles arquivos gráfi cos chatinhos com 

esquema de cores CMYK. POR JASON WALSH

Editoração mais profi ssional com o Scribus

Tipografi a
 e texto

Figura 1: Editando o estilo
das linhas.
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extremidades das linhas e como elas se 
unem. Para nosso projeto, deixe essas 
confi gurações no padrão: Flat Cap e 
Miter Join.

A seguir, ajuste a largura da linha 
para 2 pt e a cor para preto. Finalmente, 
clique OK e o estilo estará defi nido.

Para aplicá-lo, clique com o botão 
direito na imagem e chame a janela de 
propriedades com a opção Show Proper-
ties. Escolha Line (Linha) e selecione o 
estilo recém-criado da lista na parte de 
baixo da janela.

Esse processo de defi nir um estilo 
e aplicá-lo a uma imagem ou caixa de 
texto é a chave para a editoração pro-
fi ssional, uma vez que permite que o 
usuário crie layouts consistentes rapida-
mente e com a segurança de que serão 
uniformes em todo o documento.

Limpeza da Página
O mesmo processo é repetido para a 
pequena coluna da direita: desenhe 
uma moldura, importe uma ilustração, 
ajuste o tamanho e aplique o estilo.

Uma pequena legenda relativa 
à fotografia virá sob essa imagem. 
Vamos ignorar essa legenda neste 
momento, mas não deixemos de reser-
var um espaço para ela. Abaixo da 
legenda vai o código de barras ISSN e 
uma propaganda.

Os anúncios são imagens criadas num 
programa de editoração e exportadas 
como arquivos EPS (“Encapsulated Post-
Script” – PostScript encapsulado). São 
importados da mesma maneira que as 
fotos: desenhe uma moldura e selecione 
Import>Get Picture. Diferente das foto-
grafi as editoriais, os anúncios não têm 

uma linha de dois 
pontos em torno 
deles. Em vez disso, 
trazem uma mol-
dura de um ponto, 
que já é parte inte-
grante da imagem 
mesmo antes de ela 
ser importada.

O código de bar-
ras é exatamente 
a mesma coisa: 
outro arquivo EPS, 
embora dessa vez 
seja criado em um 
programa especiali-
zado. Nenhuma mol-
dura é necessária.

Antes de instalar o plugin, verifi que se o seu Gimp já não o possui. Muitas distribuições do Linux 
incluem o gimp-cmyk como parte de sua instalação padrão do Gimp. Por exemplo, esta série foi 
produzida usando o SuSE Linux 9.1, que traz o “gimp-cmyk” instalado como padrão. O mesmo se 
pode dizer do Debian Sarge, que possui o Gimp 2.2 já com o plugin para CMYK.

Uma versão binária do plugin gimp-cmyk está disponível, compilada para SuSE Linux 8.0, no site 
de desenvolvimento: http://www.blackfi veservices.co.uk/separate.shtml

Se você usar uma distribuição Linux diferente, ou quiser compilar no SuSE sua própria versão do plu-
gin, precisará ter instaladas  as bibliotecas Gtk, Gimp, LibTIFF e LCMS. Se já as tiver instaladas, basta:

make clean
make

Se o gimp-cmyk estiver instalado em seu sistema, será possível converter uma imagem RGB 
para o formato CMYK clicando com o botão direito na foto e selecionando “Imagem” no menu.

Um plugin do Gimp para CMYK é útil para nossos fi ns, mas CMYK numa rotina de trabalho não-colorida 
não seria o ideal. Num futuro não tão distante, os desenvolvedores do Gimp planejam passar a uma 
biblioteca gráfi ca mais genérica chamada GEGL. Essa manobra permitiria o suporte nativo a CMYK.

Instalação do plugin gimp-cmyk

Imagens de tela, como vemos na Internet, 
estão tradicionalmente em resolução de 72 
pontos por polegada – isso signifi ca que cada 
polegada da imagem é composta por 72 pon-
tos. Se você tentar imprimir imagens da web, 
elas fi carão granulosas e falhadas, já que essa 
resolução é demasiado baixa para impressão.
Ao imprimir em casa, a maioria das pessoas cria 
imagens com resolução de 300 dpi. Essa é uma 
resolução bastante segura, alta o sufi ciente para 
ser usada na maioria dos casos – na verdade, é 
desnecessariamente alta para um jornal.
Para perceber qual resolução usar para nossas 
imagens, é importante compreender o que 
está acontecendo com elas. Imagens impres-
sas consistem de pontos em meios-tons (se 
você escanear uma página de jornal ou revista, 
verá esse padrão de meios-tons - ver fi gura 5).

Meios-tons não são medidos em pontos 
por polegada (dpi – dots per inch), mas em 
linhas por polegada (lpi – lines per inch). Esse 
processo é chamado screening. Quanto mais 
alto o valor de lpi, mais pontos de meio-tom 
são colocados por polegada; o resultado 
fi nal é uma imagem de resolução maior. 
Jornais são impressos com 65-85 lpi, revistas 
com 100-150 lpi e livros entre  150-300 lpi.
Cada ponto de meio-tom é composto de 
pequenos pontinhos medidos em dpi. O dpi 
efetivo é o número máximo desses pontos que 
a impressora pode imprimir em uma polegada.
A razão de dpi para lpi fi ca normalmente entre 
150 e 200%; por conseguinte, se sua tela meio-
tom tem 85 lpi, suas imagens precisam estar 
numa resolução mínima entre 127,5 e 170 dpi.
A resolução relativamente baixa da tela de 
meio-tom, ou seja, 85 lpi, é adequada para jor-
nais porque a tinta vai se esparramar pelo papel 
de baixa qualidade usado em sua impressão.
Claro que não dói deixar uma resolução leve-
mente maior do que o necessário, de forma 
que todas as nossas imagens estejam em segu-
rança com 200 dpi. Embora essa resolução seja 
alta o bastante para um jornal e permita que 
as imagens sejam ligeiramente ampliadas, se 
as imagens em 200 dpi forem impressas numa 
revista com um papel de maior qualidade o 
resultado não será muito satisfatório.

Resolução

Figura 5: Uma imagem publicitária do come-
diante Bill Bailey escaneada de um jornal 
irlandês. Note os pontos de meio-tom visí-
veis, formando um padrão na imagem.

Figura 2: A primeira página até agora, sem o texto.
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Rumo ao Texto
Agora que nossa imagem principal está 
em seu lugar, vamos voltar a atenção 
para o texto. O primeiro passo é sele-
cionar um estilo de tipos. Muitas fontes 
foram projetadas especifi camente para 
jornais. Para editoração profi ssional de 
jornais, vale a pena fazer um pouco de 
pesquisa sobre tipos.

No caso do East Belfast Observer, o 
texto do corpo (ou seja, o texto das notí-
cias) é feito numa fonte chamada News 
701. A News é uma fonte serifada, legí-
vel até mesmo em tamanhos pequenos 

– perfeita para jornais. Como não tenho 
uma licença para usar essa fonte neste 
projeto, usarei outra fonte serifada, a 
Bauer Bodoni. Qualquer fonte serifada 
bem projetada, como a Times, seria ade-
quada para o texto principal, mas fontes 
como a News têm vantagens espaciais 
por serem desenvolvidas especifica-
mente para uso num jornal.

Na verdade, o segredo para um bom uso 
de fontes é simples: escolha tão poucas fon-
tes quanto possível e atenha-se a elas. Isso 
oferecerá ao leitor clareza e consistência.

Em nosso caso, todos os cabeçalhos 
são variações em negrito da fonte Gill 

Sans. No caso das notícias 
em si, é melhor importá-
las de arquivos de texto; 
quanto aos cabeçalhos, 
basta desenhar uma caixa 
de texto, digitar o neces-
sário e ajustar o estilo.

Assim como com os 
outros elementos no pro-
jeto da página, vamos 
criar um estilo para o 
texto principal – o das 
notícias – e aplicá-lo a elas. 
Escolha Edit>Paragraph 
Styles e clique New na janela Edit Style. 
Chame esse novo estilo de Body Text 
News (fi gura 3).

As opções que estamos usando são as 
seguintes: A fonte é Bauer Bodoni Regu-
lar com o tamanho de 10 pt. O tama-
nho que você dá a seu tipo depende da 
medida individual da fonte. Por exem-
plo, uma fonte relativamente grande 
como a News 701 seria ajustada para 8 
pt, enquanto com a Times o tamanho 
pode chegar a 12 pt.

O espaçamento entre linhas (Line 
spacing/leading) é configurado para 
110% do tamanho da fonte – ou seja, 

se a fonte tem 10 pt, use 11 pt, com 
uma confi guração de fonte de 8 pt use 
um espaçamento de 8,8 pt e assim por 
diante. Isso é muito menos que a con-
fi guração padrão e dará ao texto uma 
cara densa e séria.

Grande parte do resto das confi gura-
ções é questão de opinião. Neste caso, 
tomamos a decisão de “justifi car” o 
texto das notícias (o texto forma uma 
linha reta nos dois lados da coluna). 
Repetimos, isso contribui para o ar de 
seriedade do texto. Evite centralizar, 
alinhar à direita e posições forçadas a 
qualquer custo: essas configurações 

Figure 3: A caixa de diálogo usada para confi gurar o estilo do texto.
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não ajudam em nada no texto principal.
O resto das confi gurações pode ser 

mantido nos valores padrão. Clique 
OK para voltar à janela Edit Style (Edi-
tar Estilos). Marque Body Text News e 
selecione Duplicate. Mude o nome para 
Body Text Comment e o alinhamento 
para Align Text Left. Clique OK. Assim 
como notícias factuais se benefi ciam 
do texto justifi cado que as faz parecer 
mais densas, artigos de comentário, 
opinião e entretenimento ganham com 
o alinhamento à esquerda, pois a mar-
gem direita desigual os faz parecer mais 
leves. Feche a janela Edit Style.

Importando e 
ajustando o texto
Olhe um jornal com atenção; você vai notar 
que, diferente de muitas revistas, as notícias 
cabem direitinho no lugar destinado a elas, 
sem espaço em branco sob a última linha. 
Isso ajuda a dar um ar sóbrio e profi ssional 
às páginas de notícias e, obviamente, que-
remos reproduzir isso em nosso teste. Ajus-
tar sutilmente o kerning e o tracking ajuda 
um pouco, mas o único modo de fazer isso 
direito é editar ou “remendar” o texto e 
fazê-lo caber. Essa é uma das principais 
razões por que as páginas são projetadas 
por sub-editores e não pelos diagramado-
res: a compreensão das regras da língua e 
a forma como fazer um texto fl uir exige a 
travessia de um longo caminho.

Vamos remendar nossa notícia da pri-
meira página. Desenhe uma caixa de 
texto sob o cabeçalho com exatamente 
a mesma largura, mas alta o bastante 
para chegar quase embaixo – digamos, 
cerca de 1,5 cm acima da margem.

Embaixo, desenhe outra moldura simi-
lar que encoste na margem inferior. Essa 
moldura conterá informação sobre o que 
mais há no jornal e determinará até onde 
nossa notícia principal pode chegar.

Importe o texto normalmente (Sele-
cione a moldura de texto e vá em 
File>Import>Get Text). A seguir, apli-
que o estilo do Texto Principal em 
Tools>Properties. Na caixa de diálogo 
Properties, selecione text e escolha o 
estilo apropriado (Body Text News). A 
seguir, vá em Shape e selecione 3 colu-
nas. Lembre-se de deixar um espaço 
entre as colunas, digamos, de 2 mm. 
Isso é feito editando-se o valor das 
Columns na seção Shape (Forma) da 
caixa Properties.

Feche a caixa Properties. Qualquer 
arquivo de texto razoavelmente grande 
serve – neste caso, estamos usando 
uma cópia das primeiras centenas de 
palavras deste artigo, já que não temos 
acesso à notícia verdadeira.

Agora a melhor parte (ou a pior – depen-
dendo de sua opinião). Edite manualmente 
o texto para que se encaixe no espaço 
dado, como se você fosse um editor.

Retoques Finais
Tudo o que falta agora é fi nalizar a página. 
Na fi gura 4, você pode ver os elementos 
restantes que precisam ser adicionados.

 Em primeiro lugar, acrescente o cabe-
çalho da notícia secundária no lado 
direito da página. A fonte do cabeçalho 
é Gill Sans Bold; ajuste o tamanho.

A seguir, abaixo da notícia principal, 
acrescente, ainda em Gill Sans Bold, os 
detalhes do conteúdo do resto do jor-
nal. Lembre-se que uma moldura já foi 
criada para isso.

Depois, abaixo do nome mas acima 
da imagem principal está um destaque 
da seção de variedades. Esse destaque 
consiste de uma caixa de imagem e uma 
caixa de texto.

A última tarefa é fi nalizar os três des-
taques principais no alto da página.

Destaques
No mês passado escrevemos “The new 
newspaper for East Belfast” no alto da 
caixa à extrema esquerda. Vamos repetir 
isso agora e iniciar o processo de adicio-
nar texto e imagem às duas outras caixas.

Trace uma caixa de texto sobre o 
retângulo da extrema esquerda e digite 
as palavras: “O novo jornal do East 
Belfast”. Em seguida, ajuste a fonte, o 
tamanho e o espaçamento. Decidimos 
por valores de texto de 42 pt, na fonte 
Gill Sans Italic, com um espaçamento 

O que esses termos signifi cam?

Serifa e Sem Serifa

Embora haja muitas subcategorias, a divisão básica das fontes é entre 
serifadas e não-serifadas. Serifas são os “tracinhos” nas extremidades 
das letras, que na verdade representam as marcas de cinzel dos anti-
gos artesãos romanos. 

Fontes serifadas são consideradas mais elegantes, suaves, sérias e legí-
veis, sendo por isso comumente usadas para grandes blocos de texto 
– confi ra num romance ou num jornal.

Uma fonte sem serifa (ou, menos comumente, Grotesca) não apre-
senta esses detalhes. Sua aparência modernista dinâmica as torna 
adequadas para textos de tamanho maior, como títulos, textos em 
pôsteres e livros de arte inexoravelmente “moderninhos”.

Entrelinhas e Espaçamento

O espaçamento entre linhas, como é conhecido no Scribus, é chamado, 
em inglês, de leading – “lead” signifi ca “chumbo” e traz referência às 
tiras de chumbo usadas para criar espaço entre as linhas no tempo da 
tipografi a mecânica. Em português, o nome é “Entrelinhas”.

As entrelinhas permitem ao diagramador alterar a densidade dos blo-
cos de texto. Jornais são bastante densos e usam um valor de espaça-
mento menor do que o usado em revistas, panfl etos ou pôsteres.

Kerning e Tracking (Entreletras)

Quando uma fonte é projetada, o projetista atribui a cada caractere 
uma largura, permitindo que caracteres consecutivos sejam colocados 
numa linha sem se tocar. Porém, as intenções do projetista das fon-
tes podem não ser iguais às suas. O Kerning permite que você ajuste 
manualmente o espaço entre dois caracteres quaisquer. O Tracking 
(Entreletras)  permite que o usuário aplique uma forma de espaça-
mento universal entre todos os caracteres. Dessa forma, é uma opção 
importante e, logo que você encontre uma confi guração que julgue 
adequada, eu o aconselho a deixá-la em paz e ajustar o kerning manu-
almente para mudanças menores.

Defi nições de Tipo

Figura 6: Fontes serifadas e não serifadas.
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Jason Walsh foi diretor 
de arte do East Belfast 
Observer desde o lan-
çamento, em janeiro 
de 2004, até julho de 
2004. Antes disso, era 
diretor de arte das 
elegantes revistas britânicas Gorgeous 
e CityCraic. Atualmente trabalha como 
jornalista e contribuiu para a Linux 
Magazine, a Variant, a Mute, o jornal 
The Guardian e muitas outras publica-
ções sobre arte, design e tecnologia.
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[1]  Para a primeira parte da série “Layout no 
Linux” consultar: Jason Walsh: “Um Jornal 
Via Linux”, Linux Magazine Brasil, edição 
5, pág. 32.

[2]  Scribus: http://www.scribus.org.uk/

[3]  News Page Designer:
http://www.newspagedesigner.com/

[4]  Society for News Design:
http://www.snd.org/

[5] News Today: http://newstoday.com/

INFORMAÇÕES

 A tipografi a é uma arte, algo que os candidatos 
a doutor passaram seus mestrados esforçando-
se para compreender. Nossa simples introdu-
ção não pode ir muito além de uma visão geral 
da tipografi a; assim, se você quiser aprender 
mais sobre tipos mas nem sonha ingressar 
numa faculdade de artes, alguns bons livros 
serão uma mão na roda:

Stop Stealing Sheep and Find Out How 
Type Works. Por Erik Spiekermann.

O guia clássico da Adobe Press para enten-
der a tipografi a. Esse livro disseca o assunto 
do início ao fi m, oferecendo uma rica base 
para o uso de fontes e tipografi a.

The Mac Is Not a Typewriter. 
Por Robin Williams.

Obviamente destinado a usuários do Macin-
tosh, esse livro é ainda uma prática referên-
cia para os interessados em editoração de 
páginas em qualquer plataforma. Tópicos 
tratados: aspas inglesas versus aspas 
genéricas, travessões en ou em, tabulações 
e recuos, kerning, entrelinhas, espaço em 
branco, viúvas, órfãs e pontuação sobrando. 

Designer’s Handbook. 
Por Alastair Campbell.

Este simples manual já é meio antigo, mas 
ajuda a compreender todo o jargão que os 
impressores cospem em você, desde PANTONE 
até sangramento, trapping e muito mais.

Tipografi a avançada

Figura 4: Primeira página pronta.

de 36pt. Posicione a caixa de texto de 
forma que fi que dentro da caixa azul.

A seguir, desenhe duas caixas de ima-
gem, uma sobre cada uma das caixas 
restantes. Dentro delas, importaremos 
fotografi as, mas antes precisamos recor-
tar as imagens (com o recurso path). 
Isso signifi ca traçar uma linha em torno 
do aspecto da imagem que se quer usar, 
permitindo que o Scribus descarte o 
resto da imagem.

Abra as fi guras em seu editor de 
imagens. Seja ele PixelFX!, PhotoPaint 
ou GIMP no Linux, ou Photoshop no 
Mac/Windows, o processo é similar. 
Explicaremos como fazer isso no pró-
ximo artigo .

Em nosso caso usaremos uma foto 
publicitária da atriz francesa Audrey 
Tatou e uma imagem PR em alta resolu-
ção de um iPod, baixada do site da Apple.

Pare, repita, repita novamente.
Agora que já quase acabamos de criar a 
primeira página, o processo deve ser repe-
tido para as outras páginas. A contracapa 
fi ca ao lado da primeira página e, na tra-
dição dos jornais anglófonos, é a página 
de esportes. As outras duas páginas mos-
tradas são a capa da seção de variedades 
e uma página de notícias. Se você vem 
seguindo este tutorial, será capaz de criar 
páginas similares com bastante facilidade.

No próximo mês
No capítulo fi nal da série, daremos os 
retoques fi nais na página, explicaremos 
como usar modelos para criar um docu-
mentos de muitas páginas e daremos 
uma olhada mais de perto na forma 
de levar as páginas ao prelo. Também 
pediremos que um profi ssional de pré-
impressão avalie o jornal pronto. ■


